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1. [bookmark: _Toc101784089]Introduction

With the Morphing Editor application, you can design morphing projects with images that you choose to morph together. 

1.1. [bookmark: _Toc101784090]Overview
First, drag the images that you want to morph to the table in the main window.

If you put the images in a directory derived from the directory where you save the Morphing project, then the relative filename of the image will be taken from where the project is saved.
This is useful in the case that you want to move the project to another location or transfer it to another computer.

If the images are in a different location, then the full file names will be saved. You will not be able to move the images or transfer them to another device if they are not in the same location.

Next, choose a master image.
It's recommended to not change the master image after initially choosing one. If you decide to change the master image, the vertexes will be in a different position and may change the triangulation.

Select the area of the master image where you want the morphing to take place, as explained in this point:  3.4 - Window for defining Morphing frame

Select the Morphing area in the rest of the images.
The Morphing frame of the master image is used as the relationship aspect for the rest of the images.

You can adjust the Morphing area of any image at any time by moving or resizing it. 3.4  - Window for defining Morphing frame

Then, return to the master image and insert the vertexes of the mesh, as explained in this point:   3.3.2 - Editing panel
The vertexes are inserted in all of the images, mapping each new vertex in the triangulation of each image.
For optimal results, when choosing the vertexes, delineate the specific areas that you want the morphing to take place (i.e. mouth, nose, hair, eyes and surroundings, etc.).


The vertexes will most likely not be in the same position across the different images (for example, the mouth will be in a different position in each image). Therefore, once you have defined the vertexes of the master image, you will then need to move each vertex to the appropriate position image by image.
(Está claro que los vértices no ocuparan la misma posición en distintas imágenes, ya que por ejemplo, la boca estará en una posición distinta en cada imagen).
To prevent undesired effects, like uncolored areas, in the Morphing simulation, keep the vertexes that are on the edge of the Morphing frame there.

Here are some useful tools that can help you identify the vertexes between images:
· When you click on a point in the image that is inside the Morphing frame, the triangle where you clicked in is selected, and is indicated by an outline in a different color and numbering its vertexes. 
If you don't click on another triangle and switch images, the same selected triangle is highlighted. 
· You can fade to the master image at any time: the current image is faded to the master image at the percentage you choose with a scroll bar. This tool overlays the master image on the current image, which you can then use to try to guess which zone corresponds to which zone.
When you change the image or the zoom factor, or if you press escape, the fade disappears. 

You can add new vertexes at any time; however, it’s better to do so first in the master image, and then move them to the rest of the images.

You can also delete the vertexes at any time (deleting a vertex in one image will subsequently delete the vertex in all the other images as well).

You can move the vertexes separately to each image (i.e., if you move a vertex in one image, that vertex does not move in the other images).


When moving the vertexes of the master image, you should try not to move them too far away from their original position, as this could change the triangulation, causing the triangles to overlap and the vertexes of the other images to be in the wrong position.

When you have defined all the vertexes and want to duplicate an image to put it in a different position, you can clone the image with the same vertexes.     3.1.2.2 - Row pop-up menu

When you have carefully placed the vertexes in each image, you can launch a morphing simulation.  3.2.3 - Tools menu


You can save the Morphing project at any time.
The data saved for each image is:
· The name of the image (which cannot be changed).
· The name of the image (that is assigned automatically).
· The Morphing frame.
· The coordinates of the vertexes
· If the image is a master image or not.



When you have finished a Morphing project and don't need to make any more changes, you can open the project with the Video Creation application and create a morphing video of the project.





1.2. [bookmark: _Toc101784091][bookmark: _Hlk100417114]Visual appearance of the screens
1.2.1. [bookmark: _Toc101784092]Main screen

The Main screen looks like this:
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The screen has the following features:
· Main menu on the top line
· Top row:
· Text editor: Name of Morphing project.
· Open, Save, and Save As Morphing Project icons.
· Text editor: name of the Morphing project file.
· Table
Table of images
· Bottom part:
This is where the Morphing simulation is displayed when a simulation is launched.


1.2.2. [bookmark: _Toc101784093]Editing window:

This is what the editing window looks like:
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The screen has the following options:
· Top control panel:
· Drop-down: Zoom factor
· Image browser
· Master:
· Indicates if the current image is the master image. 
· Button that makes this image the master.
· Fade to master:
· Scroll bar with the master image percentage.
· Apply button: Fades to the master image by the percentage indicated by the scroll bar.
· Button to open the Morphing framing window. 3.4 - Window for defining Morphing frame
· Button to delete all the vertexes of the triangulation.
· Lower content panel.
· Image:
Image with its triangulation.


2. [bookmark: _Toc101784094]Quick Start
2.1. [bookmark: _Toc101784095][bookmark: _Hlk62154041][bookmark: _Hlk62155160]Requirements

To run the application, Java Runtime Environment version 8 or higher needs to be installed.
This allows you to open the .jar file located in the ./_binary/ folder.

The directory where the Java application is located must be in the PATH environment variable.

2.2. [bookmark: _Toc101784096]Quick Start

The instructions for two different operating systems are detailed:

2.2.1. [bookmark: _Toc101784097]Windows (64 bits)
2.2.1.1. [bookmark: _Toc101784098]Morphing editor
To start using the application, follow the steps below:
· Start the program by double-clicking on the executable file in:  …/_binary/morphing-gui-v1.0.exe

2.2.1.2. [bookmark: _Toc101784099]Morphing video creator
To start using the application, follow the steps below:
· Start the program by double-clicking on the executable file in:  …/_binary/morphing-video-builder-v1.0.exe

2.2.2. [bookmark: _Toc101784100]Linux and Mac
2.2.2.1. [bookmark: _Toc101784101]Morphing editor
To start using the application, follow the steps below:
· Open a commands window.
· Change the directory to …/_binary
· Run the script:   ./unixExecuteMorphingEditor.sh

2.2.2.2. [bookmark: _Toc101784102]Morphing video creator
To start using the application, follow the steps below:
· Open a commands window.
· Change the directory to …/_binary
· Run the script:   ./unixExecuteMorphingVideoBuilder.sh


3. [bookmark: _Toc101784103]User interface
In this chapter you will learn how to use the main window panes.

3.1. [bookmark: _Toc101784104]Main window
The main window looks like this:
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3.1.1. [bookmark: _Toc101784105]Top panel options

The top panel has various options:
· Text Editor (Top left). Change the name of the current project.
· “Open Project” button. To open a new project saved on the computer's hard drive. 
· “Save Project” button. To save current project in the location specified in the Text Editor: project file name.
· “Save Project As...” button. To save the current project with a different name.
· Text Editor (Top right). View and change the project file name.

3.1.2. [bookmark: _Toc101784106]Table of images

A table where you can find the images of the project.
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You can perform the following actions:
· Add images by dragging them from the file browser to the desired position.
The location of the images cannot be changed.
If the images are found in the project file directory, or in a child directory, the relative name from the project directory is used.
Since you CANNOT edit the location of the images once added, if the images are in a subdirectory of the project directory, then you can transfer the entire project directory to another device or even to another operating system (projects from Linux operating systems can be opened in Windows, and vice versa).
(HOWEVER, IN ORDER TO DO THIS, THE IMAGES MUST BE IN THE MORPHING PROJECT DIRECTORY)
· Change the image order by selecting the images that you want to move and dragging them to another position in the table.
· Delete images by selecting the images you want to delete and pressing the Delete key, or with the row pop-up menu.
· Change the order of the columns by dragging the heading that you want to another position.
· Resize the width of a column by dragging the right border of the heading until you have the desired size.
· Resize the width of a column to fit the content by double-clicking on the right border of the heading you want to resize. 
· Add or remove columns with the heading pop-up menu.
· Reorder columns in ascending or descending order with the heading pop-up menu.

3.1.2.1. [bookmark: _Toc101784107]Heading pop-up menu
When you right-click the heading of the image table, a pop-up menu appears.
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It has the following options:

· Section 1
· Adjust this column. Fit column width to content.
· Adjust all of the columns.  Fit all column widths to content.
· Always adjust all columns. Automatically adjust all columns whenever the table content changes.
· Section 2
· Sort in ascending order by this column. Sort the images in the table in ascending order by the content of the selected column.
· Sort in descending order by this column. Sort the images in the table in descending order by the content of the selected column.
· Section 3
· Column names (They can be activated or deactivated)

3.1.2.2. [bookmark: _Ref100518103][bookmark: _Ref100518118][bookmark: _Toc101784108]Row pop-up menu
When you right-click on a table row, a pop-up menu appears.

[image: ]

It has the following options:
· Delete selected images from the list. When images are selected, you have the option to delete them. A dialog box will pop up asking you to confirm the deletion. 
· Clear selection. To unselect all images. 
· Show current row. This option is useful for long lists and when you don't know where the current row is located.  By clicking this option, you display the current row.
· Clone selected rows. When there are images selected, you can clone the image and its vertexes. This is useful in the case that you want to use the same image several times in the morphing image sequence. 

3.1.3. [bookmark: _Toc101784109]Morphing simulation panel

The lower panel shows the morphing simulation when this option is selected from the Tools menu.
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3.2. [bookmark: _Toc101784110]
Application menu
The menu is the options bar in the top line of the window.
It has different options:

3.2.1. [bookmark: _Toc101784111]File menu
The File menu looks like this:


[image: Interfaz de usuario gráfica, Texto, Aplicación

Descripción generada automáticamente]

This menu has various options:
· Open Morphing Project. Opens the file selection dialog box, and opens the project you select.
· Save Morphing Project. Save the Morphing project with the original name.
· Save Morphing Project As. Allows you to choose a new file name for the Morphing project and save it.
· Exit. Quit the application.

3.2.2. [bookmark: _Toc101784112]View menu
The View menu looks like this:
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This menu has two options:
· Zoom. Allows you to choose the size of the visual part of the application, with a percentage that indicates the size of the components compared to the normal display of the windows (100%).
· Dark Mode. Change from Dark Mode to Light Mode, or vice versa.




3.2.3. [bookmark: _Ref100518161][bookmark: _Ref100518175][bookmark: _Toc101784113]Tools menu
The Tools menu looks like this:
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This menu has two options:
· Language. When you click on this sub-menu, a list of available languages is displayed. You can change the language of the application.
The following languages are available by default:
· “EN”. English
· “ES”. Spanish.
· “CAT”. Catalan.
· Settings. This option allows you to modify the general application settings. See point:   3.5-Settings
· Simulate morphing. Launches a morphing simulation of the current project.
· Cancel simulation. Cancels the morphing simulation in progress.

3.2.4. [bookmark: _Toc101784114]Help menu
The Help menu looks like this:
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This menu has various options:
· Demos. Opens another menu where you can view demonstration videos of the application. 
· User guide. Open this file.
· Search for a new version. Prompts the server to check if the application is running the latest version.
· What's new. Shows what's new in this version, with a history of major changes.
· License. Displays the license that was accepted the first time the application was run. See section: 3.6-License
· About. When you click this menu item, a window appears with information about the application, acknowledgements, and contact details. See section: 3.7 - About...


3.3. [bookmark: _Toc101784115]Editing window:

The window for editing the triangle meshes looks like this:

[image: ]


3.3.1. [bookmark: _Toc101784116]Control panel
The upper control panel looks like this:
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It has these options:

· Zoom. Indicates the zoom level of the image in the editing pane.
· Browser. Allows you to browse through the images of the project.
· Master
· Master image. Indicates if the image is the master image.
· “Make Master Image” button If the current image wasn’t the master image, it makes it the master image.
Note that if you use this option when there is a triangulation with vertexes, the triangulation will be recreated (however, it is possible that the arrangement of the triangles will change with respect to the previous state).
· Fade to master.  Fade from the current image to the master image. (overlays the master image on the current image, applying triangle mapping).
· Scroll bar. Allows you to choose the fade intensity.
· Apply. Apply the fade to the current image.
· The fade will disappear when:
· The ESC key is pressed
· The image is changed
· The Zoom level is changed
· Frame button. Select the Morphing frame. 3.4 - Window for defining Morphing frame
· Clear All button. Deletes all vertexes.


Example of a fade to master:
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3.3.2. [bookmark: _Ref100518011][bookmark: _Ref100518022][bookmark: _Toc101784117]Editing panel

The editing panel looks like this:
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In this panel you can perform various actions with your keyboard and mouse:

3.3.2.1. [bookmark: _Toc101784118]Editing actions

You can edit actions by:
· CTRL + mouse movement Shows what inserting a vertex at the mouse position would look like.
· Right-click. Confirms the inserting of the new vertex.
· Release CTRL. Leaves the inserting a new vertex state. 
· SHIFT near a vertex: Selects the vertex.
· When there is a vertex selected:
· SHIFT + Right-click Delete vertex.
· SHIFT+ Drag and Drop Moves a vertex.
· When the mouse is in the Morphing frame and no vertex is selected:
· SHIFT + Right-click Enters the fine adjustment mode of the Morphing frame.
· SHIFT + Right-click Moves the Morphing frame.
· SHIFT + Right-click + Mouse wheel.
· Scroll up. Increases the size of the Morphing window.
· Scroll down. Decreases the size of the Morphing window.
· SHIFT + Right-click + Click mouse wheel. Confirms Morphing frame setting changes.
· Release SHIFT. Discards settings. 
· Release the right mouse button. Discards settings.
· Left-click. Selects the triangle the mouse clicked in, which is indicated by an outline in a different color and numbering its vertexes. (if you change the image, the same triangle will be highlighted and its vertexes will be numbered).
Displays the correspondence of the triangle in the image you select.

3.3.2.2. [bookmark: _Toc101784119]Other actions

You can perform other actions besides editing:

· Left-click + Drag-drop. Moves the scroll bars of the image, in the case that it doesn't fit completely in the editing pane.
· CTRL + Mouse wheel.
· Scroll up. Zoom in.
· Scroll down. Zoom out.



3.4. [bookmark: _Ref100517916][bookmark: _Ref100517928][bookmark: _Ref100517951][bookmark: _Ref100517964][bookmark: _Ref100518206][bookmark: _Ref100518219][bookmark: _Ref100518286][bookmark: _Ref100518297][bookmark: _Toc101784120]Window for defining Morphing frame
From the control panel of the Morphing editing window, there is a button: [image: Imagen que contiene Interfaz de usuario gráfica

Descripción generada automáticamente] which allows you to open this window and define the Morphing frame.

The window looks like this:
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3.4.1. [bookmark: _Toc101784121]Aspect ratio

You can choose to keep the aspect ratio, in which case the width/height ratio of the Morphing area of the master image is maintained.
Although it is not mandatory to keep the aspect ratio, it is recommended.

3.4.2. [bookmark: _Toc101784122]Editing the Morphing frame

You can select the Morphing area for the image by the following ways:
· With the spinners.
· By dragging/dropping with your mouse.


3.4.3. [bookmark: _Toc101784123]Confirm changes

You can:
· Cross button. Cancel changes.
· V button. Confirm changes.
· Arrow button. Discard changes and continue editing.


3.5. [bookmark: _Ref15224742][bookmark: _Ref15224750][bookmark: _Toc101784124]Settings
This window allows you to change the general application settings.
The window has several tabs:
3.5.1. [bookmark: _Toc101784125]Application language settings
The tab looks like this:
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[bookmark: _Hlk14020397]
You can configure the following settings:

· Language. The language of the text of the application.
You can choose the following languages:
· EN English
· ES Spanish.
· CAT. Catalan.
· Language locale. The Java locale that will be used by the application for this language.
The application uses it to convert numbers to formatted numeric strings.
· Additional language. A new additional language that appears when you access the language settings.
For the new language, you need to select the Java locale to use.
If you want to set the language to a language that is not available in the application, you can add your language by translating the files inside the directory that is created when you click on the "Add Language" button.
The translated files are copied to the directory indicated in:  "Additional language directory”
The text files are copied in a format for Java properties.
If you are unfamiliar with this format, note that the file has a title, and after it, a tag variable number with its value, similar to the following:

# TITULO
# xxxxxxxxxx
ETIQUETA1=texto 1
ETIQUETA2=texto 2
...

The tags must stay the same while the texts can be modified depending on the translation in the chosen language.

In addition, there are some files in RTF format, which you will have to translate with an RTF editor (a typical editor for that format is Office Word).


If you create a translation for an additional language other than the ones available in the application, you can send it to me (frojasg1@hotmail.com) and I will include it in the next versions of the application.

3.5.2. [bookmark: _Toc101784126]Application view settings
The tab looks like this:
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· Application window size. These settings allow you to control the appearance of the windows of the application. You can choose the small size, the normal size, or the large size.


3.6. [bookmark: _Ref15224872][bookmark: _Ref15224879][bookmark: _Toc101784127][bookmark: _Ref15224815][bookmark: _Ref15224823]License

The “License” tab, located in the Help menu, displays the license that was accepted the first time the application was run.

It looks like this:
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3.7. [bookmark: _Ref100518249][bookmark: _Ref100518263][bookmark: _Toc101784128]About...

The “About...” button displays a window with a summary of what is new in this version. Acknowledgements are also included.

It looks like this:
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The idea for this application has been in my mind for some time. Ever since I was young, I've been fond of programming, and liked to watch the demos that many teams of computer programmers hosted for different demo competitions around the world.
      
        I was impressed by many of the demos, considering the capacities of computers at that time. Once, I saw a demo of a Spanish team that used a morphing effect: the members of the team morphed from one to another, and lastly into an iguana (this was fitting, as the team’s name was Iguana). It was an effect that caught my attention. 

Over the years I have been thinking about how to achieve this effect, and finally have figured out a way to do so. Now, as the final product of my efforts, I am pleased to present you with this application. I have also compiled a user guide that explains how the application works step-by-step.
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GPL license v3.0 or later:

http://www.gnu.org/licenses/gpl.html

The main library of the Morphing project Editor v1.0
(morphing-gui-v1.0-SNAPSHOT jar), is offered under the LGPL v3.0
license or later:

http://www.gnu.org/licenses/Igpl-3.0.txt

The following libraries used by the application (also programed by
me):

libGeneric.v1.4.jar

libGenericDesktop.v1.4.jar

libGenericCommandlLine.v1.4.jar

liblnetQuery.v1.4.jar
libDelaunayTriangulation-v1.0-SNAPSHOT.jar
libMorphing-v1.0-SNAPSHOT. jar

They are offered under the LGPL v3.0 license or later.
http://www.gnu.org/licenses/Igpl-3.0.txt

The following libraries (obtained with free code from Internet,) are
also used by the application:

libTableColumnAdjuster.v1.0.jar

libScreenlmage.v1.0.jar

iuniversalchardet.1.0.3.iar
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With this application you will be able to create Morphing projects through creating triangle

Send e-mail to: frojasg1@hotmail.com
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